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Every now and again, we are all forced to update
our equipment. The laptop I’m using to write this is a
Lenovo G530. It was purchased new in 2008-ish,
and has a 160GB HD, 3GB RAM, running on a dual
core Intel processor. It originally came with Windows
7, which was quickly replaced with PCLinuxOS KDE
4. It now runs PCLinuxOS Xfce fairly well. But, after
10 years, it’s really starting to show its age.

Yes, I do tend to “push” things a bit. Currently
running on this laptop is Firefox Quantum with 16
open tabs, Scribus for the magazine layout,
HexChat, Thunar with three different tabs, xfce4-
terminal, and Dropbox … and that’s just the things
you can see. There’s a whole host of other programs
running in the background, or things you might not
think to include, like the wireless interface,
pulseaudio, data and time panel plugin, battery
monitor, clipboard, a CPU load monitor, and all the
files necessary for the Xfce desktop. All said and
done, that isn’t too bad for a 10 year old laptop with
only 3GB of RAM. Every once in a while I’ll push the
laptop too hard, and things will start to crawl when
too much data is written to the swap partition and
has to be swapped into and out of physical memory.

One of the things I’ve missed on this laptop for all
those years was a memory card reader slot.
Whenever I need to use a card reader, I have to pull
out my USB memory card reader, and hook it up via
a USB hub (the USB ports are placed too close
together to be able to use the USB memory card
reader with my wireless USB mouse receiver). It’s
not a perfect laptop, but it has served me well for
nearly a decade. Plus, at the time that I bought it, it
was at the upper limit of what I could afford at the
time. The sale that Newegg.com had on it helped,
too.

Well, by next month’s issue, that will all change. I’ve
managed to buy a “newer” laptop. It’s pretty much
the same laptop that Meemaw purchased last
October, and you can read her new laptop story
here. Just like Meemaw’s, it’s a Lenovo IdeaPad 320
with a quad core AMD A12 processor, 8GB RAM, a
15.6” screen, and a 1TB HD. Plus, it has a memory
card reader slot! It also has Bluetooth 4.0, and a
number keypad (I’ve never had THAT on a laptop
before!).

I purchased it on Ebay from a college student who
claimed that it “wasn’t fast enough to run some of
the programs he needed to run.” My translation of
that statement was that he played games and the
IdeaPad isn’t designed to be a gaming laptop. I also

knew if my 10 year old laptop could do all that I’ve
asked it to do over the years, the IdeaPad would be
more than sufficient for my needs. Plus, Meemaw
has had no problems or complaints with her laptop.

I lucked out and won the bid on the IdeaPad, getting
it for a $295 winning bid (only $5 less than my “max”
bid). On that particular day, Ebay put out a 15% off
coupon, good for any one item purchased that day.
So, in the end, I ended up paying only $255 for the
laptop, after applying the coupon. It also helped that
shipping was free. It wasn’t supposed to arrive until
September 5, but ended up arriving on September 1.
Great job, U.S. Postal Service!

From The Chief Editor's Desk . . .

https://pclosmag.com/html/Issues/201711/page03.html
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It came with Windows 10 on it, which the college
student and previous owner spent most of a day
restoring before shipping it to me. I did boot into it,
but after more than a decade running Linux, Win10
just wasn’t for me. Some things were just laughable
in the way they were implemented, other things “felt”
like the same ol’ Windows, and yet other aspects of
it felt very alien and foreign.

So, I’ve installed the community remaster of
PCLinuxOS Xfce, produced by Ika. Windows 10 is a
distant memory on the IdeaPad. Admittedly, I used
Meemaw’s article as a guide, since I had never dealt
with UEFI and Secure Boot. I also remembered she
had some “tricks” to get the wifi going. Just as with
Meemaw’s laptop, my touchpad does not work. But,
since I hate touchpads (and avoid their use as much
as possible), I’m OK with it not working. I much
prefer a wireless USB mouse, anyways.

But, since my old laptop is still working, I had to
transfer all my “important” files to the new laptop,
16GB at a time. All I had available was a 16GB SD
memory card, so I’d fill it up, then transfer those files
to the second data partition on the new laptop (I set
up a 30GB root partition, a 16GB swap partition, a
275GB /home partition, and two additional 275GB
partitions, named data1 and data2) by moving the
SD memory card between the two machines. Then,
repeat that process until all of the files are
transferred. Rinse, lather, repeat. Rinse, lather,
repeat.

The slow part of that process is writing the files to
the SD card on the old laptop, using the USB
memory card reader and USB hub. Transfer speeds
were rather slow. The fast part of the process was
moving the files from the SD card to the new
computer. The card reader built into the new
computer is much, much faster than the combination
of the old USB memory card reader and USB hub on
the old computer, by a factor of at least three times
faster.

So far, I’ve only done minimal customizations to Xfce
on the new laptop. It’s going to take me some time to
get everything like I like it. That includes setting up
scripts and Thunar custom actions, getting my layout
environment setup like I like, and all the other
tweaks I like to perform with Xfce to create things
just the way I like.

Pleased with the new laptop would be putting it
mildly. The new laptop is more than noticeably faster
than the older laptop it is replacing. Plus, with 8GB
of RAM, I should find myself trapped in the swap
partition bottleneck a LOT less. With the 1TB hard
drive, I shouldn’t ever (or at least for a long, long
time) be worried about running out of storage space.

By the way, this month’s cover (designed by
Meemaw) commemorates the 115th birthday of the
ice cream cone, invented in 1903. Although the
history of the ice cream cone is debated as to its
origins, all of us can agree that it’s hard to pass up
this tasty treat during the heat of summer. Here’s
Wikipedia’s entry for the ice cream cone, if you want
to read up a bit more about it.

Until next month, I bid you peace, happiness,
serenity and prosperity.

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Donate NOW

From The Chief Editor's Desk ...

http://www.gofundme.com/pclinuxos-2016
http://www.linuxforums.org/forum/
https://en.wikipedia.org/wiki/Ice_cream_cone
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by Paul Arnote (parnote)

Spyware Installed By Over 11,000,000 iOS,
Android, Chrome & Firefox Users

In today’s abundant landscape of multiple app
stores, it can be quite difficult for the security-
conscious user to find apps and browser extensions
that are trustworthy enough to be installed on the
devices we use to access the internet. Couple that
with companies that often use purposely designed
sound-alike names, and it becomes even more
challenging. On another front and creating yet
another challenge, users can circumvent app store
restrictions, and install apps and extensions from
outside official app stores. Top that off with app
stores that are improperly policed (if at all), and you
can quickly have a nightmare situation.

Some “companies” use obfuscation to keep their
true identities and affiliations in the shadows. And
that is exactly the case in this instance. As reported
on the AdGuard blog, one company, Big Star Labs,
has recently acquired several apps and extensions
that phone home to a server run by its developers
with the exact address of every web page visited.
Assigning a personal identifier to each user when
the app or extension is installed, amassing a list of
each web page every user visits (by storing it under
each individual’s personal identifier) can reveal a lot

of information about that user, including their actual
identity.

In the interest of maintaining transparency, AdGuard
“sells” ad blocker software for iOS, Android,
Windows and MacOS. Because AdGuard blocks ads
in apps outside of the web browser, you won’t find
their app listed in the Google Play store, nor the
Apple iOS App store. Blocking ads outside of a
browser seems to be a huge no-no under both
ecosystems, where that ad revenue is protected like
a walled garden. To install the AdGuard ad blocker
under iOS or Android, you will have to visit their web
page here, and select “Purchase” at the top of the
website window.

Don’t try, for example, searching for Big Star Labs in
the Google Play store. You likely won’t find it. You’re
likely to find the same situation in the Apple iOS App
Store. Instead, you have to read the privacy policy
(and how many times do you think users do that
before installing an app?). All the apps in the Google
Play store have privacy policies similar to this one.
That appears to be the only place the name Big Star
Labs shows up in a textual form. All other references
are typically in images, so their name cannot be
searched for with any reliability.

So, here is a list of the apps and browser extensions
that AdGuard has found sending user information to
the Big Star Labs servers, spying on its users
activities:

* Block Site. Privacy policy.
* Android app with 100,000+ installs.
* Chrome extension with 1,440,000+ users.
* Firefox extension with 119,000+ users.

* AdblockPrime. Privacy policy. An ad blocker for
iOS. It's hard to estimate the users count as it is not
distributed via App Store.

* Mobile health club apps. Privacy policy.

* Several popular Android utilities.
* Speed BOOSTER

an Android app with 5,000,000+ installs.
* Battery Saver

an Android app with 1,000,000+ installs.
* AppLock | Privacy Protector

an Android app with 500,000+ installs.
* Clean Droid

an Android app with 500,000+ installs.

* Poper Blocker. Privacy policy.
* Chrome extension with 2,280,000+ users.
* Firefox extension with 50,000+ users.

* CrxMouse. Privacy policy.
* Chrome extension with 410,000+ users.

If you have any of these apps or extensions
installed, and if you value your privacy even a little
bit, you might want to immediately uninstall them
from your mobile devices and computers … or, as
soon as you can.

Want to keep up on the latest that's
going on with PCLinuxOS?

Follow PCLinuxOS on Twitter!

http: //twitter.com/iluvpclinuxos

Short Topix: Dropbox Scales Back Linux Support

http://twitter.com/iluvpclinuxos
http://www.commandlinefu.com
https://adguard.com/en/blog/big-star-labs-spyware/
https://adguard.com/en/welcome.html
https://mobilehealth.club/privacy/
https://blocksite.co/
https://blocksite.co/privacy/
https://play.google.com/store/apps/details?id=co.blocksite&hl=en
https://chrome.google.com/webstore/detail/block-site-website-blocke/eiimnmioipafcokbfikbljfdeojpcgbh?hl=en
https://addons.mozilla.org/en-US/firefox/addon/blocksite/
https://adblockprime.co/
https://adblockprime.co/privacy/
https://mobilehealth.club/
https://mobilehealth.club/privacy/
https://play.google.com/store/apps/details?id=advanced.speed.booster&hl=en
https://play.google.com/store/apps/details?id=com.jappka.bataria&hl=en
https://play.google.com/store/apps/details?id=com.skyblack.androidvaultfree&hl=en
https://play.google.com/store/apps/details?id=com.ruhax.cleandroid&hl=en
https://poperblocker.com/
https://poperblocker.com/privacy/
https://chrome.google.com/webstore/detail/pop-up-blocker-for-chrome/bkkbcggnhapdmkeljlodobbkopceiche?hl=en
https://addons.mozilla.org/en-US/firefox/addon/poper-blocker-pop-up-blocker/
https://crxmouse.com/
https://crxmouse.com/privacy/
https://chrome.google.com/webstore/detail/crxmouse-chrome-gestures/jlgkpaicikihijadgifklkbpdajbkhjo
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EU Competition Commissioner Sets Her Sights
On Apple

Margrethe Vestager, the EU’s competition
commissioner, has become a thorn in the side of
Silicon Valley tech companies. One month after
fining Google $5 billion for anti-competitive tactics
linked to its Android operating system, Vestager is
now targeting the lack of standardization among
phone chargers. In particular, this could spell trouble
for Apple, with its proprietary Lightning connector.

Granted, there are a lot of people who shun Apple
products due to the closed Apple ecosystem. There
are a lot of proprietary things, including charging
adapters, in the Apple system. Undisputedly, Apple
makes a sizeable fortune just from the sale of those
items, either directly or through affiliates who have
licensed the rights from Apple.

But in 2009, Apple, along with Sony, LG, Nokia, and
10 other manufacturers, all voluntarily agreed to
standardize their phone chargers. Apple, however,
continues to use iterations of its Lightning connector,
even expanding its abilities recently to include
connecting headphones to the Lightning port, via an
adapter. To date, no Apple product has ever been
released with a microUSB port for charging or any
other use. Further complicating the issue is the
subsequent release of mobile devices that now use

USB-C connectors for charging, as well as fast-
charging protocols that use higher amperage to
charge batteries much more rapidly than was
envisioned in 2009 when the agreement was signed.

Vestager is investigating this issue again, because
nine years after signing onto the voluntary
agreement, Vestager feels that not enough progress
has been made towards fulfilling that agreement.
The tech companies all assert that there is no
reason for additional regulations, and that they are
“making progress” towards standardization.

Maybe I’m naive, but nine years seems like more
than enough time to achieve standardization of
smartphone chargers.

Firefox Add-on Could Steal Your Browsing
History

Web Security was an add-on for Firefox that came
with Mozilla’s recommendation. However, that
recommendation was based on a) over 220,000
installations, and b) a rating of 4.5 stars out of five.
Had Mozilla looked a little deeper, it probably
wouldn’t have made the recommended add-ons list.

Shortly after being given Mozilla’s recommendation,
uBlock Origin developer Raymond Hill posted to a
Reddit board, stating “With this extension, I see that
for every page you load in your browser, there is a
POST to http://136.243.163.73/. The posted data is
garbled, maybe someone will have the time to
investigate further.” Hill posted his initial finding on
August 10, 2018. On August 14, 2018, popular
German blogger Kuketz posted an article about the

same behavior. In just a matter of hours, a user on
Kuketz’s forum posted that he had managed to
decode the “garbled” data. That garbled data
revealed that the URL of every page visited was
being sent to a German server.

Within about a day or so of the discovery, Mozilla
removed Web Security and 22 other add-ons that
sent user data to remote servers. Spurred on by
Hill’s Reddit post, Mozilla Browser engineer took a
look at the source code for Web Security and other
Firefox add-ons. The add-ons were removed
because they either sent user data (including the
URLs of sites visited) to a remote server, or because
they allowed the execution of remote code.

If you have this add-on installed, you might want to
remove it completely from your computers and
devices that might be utilizing it.

Dropbox Will Support Only “Clean” ext4 On
Linux

Are you a Linux Dropbox user? If so, this bit of news
is for you. Come November 7, 2018, Dropbox will
only support a “clean” ext4 file system on Linux.
Thus, if you use reiserfs, btrfs or any other file
system that is available under Linux, you will be out
of luck. As in, you will be unable to use Dropbox.

An “official” announcement was made on the
Dropbox forum, by Jay, a community moderator.

Hi everyone. On Nov. 7, 2018, we’re ending support for
Dropbox syncing to drives with certain uncommon file
systems. The supported file systems are NTFS for
Windows, HFS+ or APFS for Mac, and Ext4 for Linux.

Short Topix: Dropbox Scales Back Linux Support

https://www.businessinsider.com/google-fined-by-eu-android-2018-7
https://finance.yahoo.com/news/silicon-valley-apos-greatest-foe-115931044.html
https://www.zdnet.com/article/one-charger-for-all-smartphones-were-getting-there-say-tech-companies/
https://www.reddit.com/r/firefox/comments/96715s/make_your_firefox_browser_a_privacy_superpower/e3z8qt0/
https://www.kuketz-blog.de/warnung-web-security-addon-fuer-firefox-uebermittelt-womoeglich-sensible-daten/
https://forum.kuketz-blog.de/viewtopic.php?f=16&t=1406#p12955
https://www.bleepingcomputer.com/news/security/mozilla-removes-23-firefox-add-ons-that-snooped-on-users/
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We’ve updated our desktop requirements accordingly
here.

A supported file system is required as Dropbox relies on
extended attributes (X-attrs) to identify files in the
Dropbox folder and keep them in sync. We will keep
supporting only the most common file systems that
support X-attrs, so we can ensure stability and a
consistent experience.

If you received a notification, but are running one of the
supported file systems, it's possible that you may have
recently had a computer linked that was running an
unsupported file system but have been since upgraded, or
that computer is no longer being used.

Hope this helps to clarify matters!

A week later, Jay posted a follow-up post.

Hi all, just a brief update regarding encryption on ext4.

If you’re running ext4 and eCryptfs and receive a
notification about moving the Dropbox folder, then it’s
because eCryptfs isn’t supported.

However, contrary to @JinHadah's post here, I can
confirm that ext4 with full disk encryption (e.g. LUKS) is
supported. We're sorry for the confusion in that chat.

If I have any further information to share in the future, I’ll
let you know.

Then, on August 23, 2018, I received the following
email from Dropbox regarding the upcoming change
to Dropbox.

This fall, we’re changing the system requirements for the
Dropbox desktop app for Linux.

Beginning October 15, Dropbox is ending support for
Ubuntu 13.10 and below, and Fedora 20 and below. You
must be using glibc 2.19 or higher to continue using the
Dropbox desktop application. Please update to a

supported Linux operating system (Ubuntu 14.04+ or
Fedora 21+) or meet the new system requirements.

As ofNovember 7, the Dropbox desktop app for Linux will
only support the ext4 file system. Dropbox will continue to
sync with supported file systems that are encrypted via
full disk encryption (e.g. LUKS). Please note that ecryptfs
is not supported. To ensure your files continue to sync,
your Dropbox folder will need to be on a hard drive or
partition that meets the new file system requirements.

Devices that do not meet the operating system or file
system requirements will not be able to use the Dropbox
desktop application.

Don’t worry—your current files aren’t going anywhere. In
addition to supported Linux operating systems, you can
still access files from Windows, Mac, iOS, and Android
apps, or through dropbox.com.

What to do next:
You can find more information about updating your
operating system on the Ubuntu and Fedora websites.

To move the location of your Dropbox folder to a
supported file system or for more information, please visit
our help center.

Below are some devices you might need to update:
* localhost. localdomain, pclinuxos, unknown version,

unknown file system

You can see a full list of your connected Dropbox devices
at the bottom of your account’s security page.

We apologize for any inconvenience this may cause. For
additional information, please see our help center.

Best,
The Dropbox team

It seems that, according to the Dropbox developers,
there are only two “versions” of Linux: Ubuntu and
Fedora. They really need to get out more.

Fortunately, PCLinuxOS has the PCLOS-Cloud
available to PCLinuxOS users. If you’re affected by
the new Dropbox change, or are just tired of their
“games,” you can always make the switch to
PCLOS-Cloud. You can read all about it here, in an
article from the December, 2014 issue of The
PCLinuxOS Magazine. Dropbox will only give you 2
GB of storage space. The PCLOS-Cloud will give
you a generous 15 GB of storage space, with
purchase of additional storage space for a
ridiculously low extra charge.

New Chrome Feature Coming That Claims To
Speed Up The Entire Internet?

I’ll admit that there are a LOT of fans of the Google
Chrome web browser (I am not among them,
however). That is easily ascertained by Chrome
occupying the top spot for the most popular/most
used web browser. Market research firm Net
Applications lists Chrome as having a 62% browser
market share (as of July, 2018), with Microsoft’s old
Internet Explorer having a 12% browser market
share, followed up by Mozilla Firefox’s browser
market share hovering around 11%.

So, how does Chrome plan to speed up the
internet? Well, as it is currently, all browsers pretty
much work the same. The entire web page is loaded
when you visit. That means all the text, as well as all
of the images. If that page makes particularly heavy
use of images, that can slow down the loading time
for that web page significantly.

However, some web pages are set up to use a
technique called “lazy loading.” With lazy loading, all
the text of a page is loaded (which is typically a
small download), and only the images at the top of
the page are downloaded and displayed initially.

Short Topix: Dropbox Scales Back Linux Support

https://www.dropbox.com/help/desktop-web/system-requirements#desktop
https://www.dropboxforum.com/t5/user/viewprofilepage/user-id/760337
https://www.dropboxforum.com/t5/Syncing-and-uploads/Dropbox-client-warns-me-that-it-ll-stop-syncing-in-Nov-why/m-p/290884/highlight/true#M42589
https://www.dropbox.com/l/AADp_ftZ8H9sMNBIyJAVD3L-sMYx-dpHlRE#linux
https://www.dropbox.com/l/AAAb2meWhMOCgHru6lzOb15msWQ444Q-fUg#desktop
https://www.dropbox.com/l/AACbQqrqZ_XMXWafU163E1_YjtVzcN3M21c/
https://www.ubuntu.com/download/desktop
https://getfedora.org/
https://www.dropbox.com/l/AABx7nDQqJop18c7O0x8cNGs0CTJwID4HpQ#location
https://www.dropbox.com/l/AAB4Urwzx4WeTH3rZUSbQjOtSa4ZyM3srGg
https://www.dropbox.com/l/AADfLAp4RzUvhd_MhktPI5XFlx8sHIl5Pgw
https://pclosmag.com/html/Issues/201412/page05.html
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Then, the downloading of the images further down
on the page are downloaded in the background
before you can scroll down to them.

According to the BGR website, Google Chrome
developers are looking to add this lazy loading
feature to every webpage that Google Chrome
displays. GHacks reported on the new feature on its
August 14 post, as well. The latter has the better
explanation of the lazy loading feature.

While there is no timetable for lazy loading’s
appearance to the general public, the feature has
appeared in Chrome Canary, the cutting edge
development version of Google Chrome. Just as
with all experimental features, lazy loading can be
withdrawn at any time, without warning. Heck,
Google does that even with “approved” features.

If you’re running the experimental Chrome Canary,
you can access the new feature by pointing your
Chrome browser to chrome://flags/#enable-lazy-
image-loading in the address bar.

Hacky hack hack: Australian Teen Hacks Apple
Servers

An unnamed 16 year old Australian teen,
enamoured by all things Apple, managed to hack

into the Apple servers many times over the past year
before being caught and arrested. Unnamed to us,
this Australian teen, who lives near Melbourne,
Australia, is reported to be well known in the hacking
community.

During his forays into Apple’s “secure” servers, he
downloaded and accessed about 90 GB of files. He
downloaded them to a folder called “hacky hack
hack” on his own Mac laptop.

While Apple claims that no customer data was
compromised, but The Age (previous link) has
reported differently.

Apple responded to the breech with the following:

"We vigilantly protect our networks and have dedicated
teams of information security professionals that work to
detect and respond to threats.

"In this case, our teams discovered the unauthorised
access, contained it, and reported the incident to law
enforcement.

"We regard the data security of our users as one of our
greatest responsibilities and want to assure our customers
that at no point during this incident was their personal
data compromised."

Apple noticed the breech, and immediately notified
the FBI. The FBI, in turn, notified the Australian
Federal Police, who conducted a raid on the teen’s
family residence. There, they discovered and seized
two Mac laptops with serial numbers matching the
devices used to access Apple’s servers, along with a
mobile phone and a hard drive.

The teen is said to have boasted about his exploits
in WhatsApp messages. Reportedly, he broke into
Apple’s servers because he was a huge fan, and he
dreamed of working there some day.

Amazingly, no one reporting on this incident
indicated if the release of three year old Apple

source code on GitHub this past February is related
to this breech. I certainly wonder if this teen is the
one who acquired the source code files that were
posted on GitHub … and that Apple forced its
removal from GitHub shortly afterwards.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

Donate NOW

Short Topix: Dropbox Scales Back Linux Support

mailto:pclinuxos.mag@gmail.com
http://www.gofundme.com/pclinuxos-2016
https://bgr.com/2018/08/14/google-chrome-download-speed-increase-coming-canary/
https://www.ghacks.net/2018/08/14/chrome-may-soon-lazy-load-images-and-frames-natively/
https://www.theage.com.au/national/victoria/melbourne-teen-hacked-into-apple-s-secure-computer-network-court-told-20180816-p4zxwu.html
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by Meemaw

Wow! The LibreOffice developers have been really
busy. We just saw LibreOffice 6.0 in January, and
reviewed it in March. Last month, they released 6.1.
The release was announced on Aug 8, and on Aug
16th, they announced that there had already been
373,758 downloads.

Let’s see what new items we can find in the release
notes.

Writer

Basic list styles have been added to the Styles
submenu. This was actually in version 6.0.5 but
appears in the version 6.1 release notes.

They have added Insert Page Number and Insert
Page Count options to the header and footer
menus.

Signature Lines

It is now possible to generate a signature line in a
document using Insert > Signature Line. This
window will appear:

Filling it out and clicking OK has this result:

After that, you can sign the signature line using a
digital certificate, if you have one.

EPUB export has been improved

From the release notes, “6.1 has improved link
support, table support, image support and font
embedding, cover image support, improved
metadata support, footnote and image popup
support and support for fixed layout. ”

The window that appears is below. As you can see,
there are numerous choices, and the export seems
to work nicely.

LibreOffice 6.1 Released

https://pclosmag.com/html/Issues/201803/page06.html
https://wiki.documentfoundation.org/ReleaseNotes/6.1
https://wiki.documentfoundation.org/ReleaseNotes/6.1
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Mail merge

The Mail merge toolbar is now automatically shown
for files that have mail merge fields in them. You can
see in the image below that since I opened a letter
that had mail merge fields in it (the address at the
bottom), the Mail Merge toolbar was already there
(outlined in red).

Calc

Anchor types have been reworked There are now
three choices:

• Anchor to cell -> Image will just move with the
cell (new)
• Anchor to cell (resize with cell) -> Image will

move and resize with the cell
• Anchor to page -> independent of any cells

When resizing images with the cell, the aspect ratio
is now considered. This only works when the image
fits into its cell. If it's larger than the cell, the start
and end cell are always kept, and moving may not
work correctly. Inserted images are again anchored
to cell by default. By default they only move with the
cell, and don't resize.

There's an option to set image anchor type in the
insert image dialog (center, top).

When copying/pasting cells, the cell anchored
images are copied with the cell.

User Interface

Highlight color customization - there seem to be
more categories for highlight colors now.

Context Menu

The Merge Cells dialog shows supportive images
now, and the three choices for handling the cell
contents (top, right).

Data

Sheet > Link to External Data supports Text/CSV
files to insert their content as data and update.

Draw

The menus in Draw have been reorganized and a
new Page menu has been added.

LibreOffice 6.1 Released
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There are some new drawing styles and they
cleaned up some of the legacy styles.

GUI

Background images in Gallery and Area Fill dialog
completely reworked

They have changed the standard color palette.

Backgrounds has a new set of default gradients.

They have introduced a new set of app icons.

The different Notebookbar implementations have
gotten many improvements and bugfixes. They are
still in experimental mode but they say the UI is
stable. I use the Tabbed Notebookbar part of the
time.

There is a new icon theme as well, Colibre, which is
the default under Windows. The Colibre icons are
available in 16px, 24px and 32px. The Elementary
theme is now the default on Gnome based desktop
environments. The High contrast theme is now Sifr.
Legacy theme hicontrast is available as an
extension. The icon themes Industrial and Oxygen
were removed because they haven’t been
maintained, but have been made available as
extensions. The Karasa Jaga icon theme has been
added, heavily inspired by (and derived from) the
Oxygen icon theme, which has been discontinued.
I’ve been using it.

Breeze icon set - there is also a Breeze Dark: it is
the Breeze set made light grey so you can see them
on the dark theme.

Colibre icon set

LibreOffice 6.1 Released
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Karasa Jaga icon set

Sifr icon set

Performance

Writer

Many of the dialogs have been changed, and some
have just been cleaned up.

Find & Replace

Edit Style, Hyperlink Dialog, Special Character
Dialog, Index Entry, Character, Paragraph

Bullets & Numbering

Table properties dialog, Spelling & Grammar dialog

Word Count dialog

Change tracking management, Insert header and
footer, Column formatting

Column/Row Grouping

Did you know you could group your columns and
rows in a spreadsheet? (For some reason, I never
needed to, so I didn’t.) Suppose you have a
spreadsheet of addresses and your sales manager
wants to see data from only one town (or two),

Simply highlight the rows you don’t need (you can
do this more than once), choose Data > Group and
Outline, then choose Group.

At the left side of your spreadsheet, you will see an
extra column with a line (below left). The addition in
this new release makes it possible to collapse or
expand any group of columns or rows with a simple
click. See the minus sign at the top of the line? It’s
the collapse button. (Notice the row numbers, below,
right, now that it’s collapsed.)

LibreOffice 6.1 Released
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Groups are organized in levels and a levels header
(for both column and row groups) is available in the
top-left corner of the outline. By clicking on a levels
header entry, groups belonging to the relative level
are collapsed or expanded altogether.

Impress

Some object & shape dialogs have been added:
Position & Size, Line and the Area dialogs.

Overall, many dictionaries have been updated.
There are many more changes listed in the release
notes. I hope any change you wanted has been
implemented.

LibreOffice 6.2 is due for release early next year

Screenshot ShowcaseScreenshot Showcase

The
PCLinuxOS
Magazine

Created with
Scribus

Posted by Agust, on August 18, 2018, running KDE.

LibreOffice 6.1 Released

http://www.scribus.net
http://pclostalk.pclosusers.com
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Ingredients

1/2 cup sugar
1 tablespoon all-purpose flour
1 teaspoon kosher (coarse) salt
1 teaspoon chili powder
1/8 teaspoon chipotle chili powder or ground

red pepper (cayenne)
1 clove garlic, finely chopped
1 lb uncooked large shrimp (21 to 30 shrimp),

peeled with tails left on, deveined
1/4 medium fresh lime

Directions

1. Heat oven to 500F. Line 15x10x1-inch pan with
foil; spray foil with cooking spray.

2. In resealable 1-gallon food-storage plastic bag,
mix all ingredients except shrimp and lime. Add
shrimp; seal bag and shake to coat with sugar
mixture. Arrange shrimp with sugar mixture in single
layer in pan.

3. Bake 7 to 9 minutes or until sugar is caramelized.
Remove from oven. Using pancake turner, turn
shrimp; squeeze juice from lime over shrimp. Place
on serving platter; serve immediately.

Tips:

To keep your guests from getting sticky fingers,
serve these shrimp with toothpicks.

Kosher salt has larger grains than ordinary table salt
and contains no additives.

PCLinuxOS Recipe Corner

Caramelized Chili Shrimp

http://www.linuxfoundation.org/
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by Paul Arnote (parnote)

Gmail and Dropbox have teamed up to make it easier for Gmail users to access
their Dropbox accounts from within Gmail.

Now I know that there are a lot of users who have a deep “dislike” for either or
both of those services. And, if you are among those who dislike either or both
services, then this article isn’t for you. But it remains that many other users use
both services, so this is something those users will want to know about.

To get started, you will need to install the Dropbox add-on from the G Suite
Marketplace. Go here to download the Dropbox add-on. Click on the “Install”
button (mine says “Installed” because I’ve already installed it). Next, enter your
credentials and grant it the permissions it requests.

The Dropbox icon will only show up when you open an email, at this
point. Notice the Dropbox icon will be the fourth one down, after the
Calendar, Keep and Tasks buttons on the right side of the Gmail window.

The first time you click on the Dropbox icon, you will need to log into your
Dropbox account, using your Dropbox login credentials. Once you’ve
done that, open an email. If that email has attachments, you should see
a window similar to the one below. Click on the file listed in the Dropbox
popup window, and that file will be saved to your Dropbox account.

Dropbox also partnered with Microsoft a few years ago to seamlessly
integrate Dropbox into Microsoft Office. Currently, you can only save
email attachments and Dropbox links to Dropbox via the add-on in Gmail.
But, according to the Dropbox blog report, “you’ll be able to share links
through a Gmail compose experience later this year.”

Of course, you can still drag and drop any file into your Gmail compose
message window by opening up your file manager, dragging the desired

file to the compose message window, and dropping it there. Or, you can always
just attach a file in the normal, “old fashioned” way, too.

For those of us who find ourselves using both services, despite their perceived or
real problems, this partnership will help streamline some tasks. The nice thing

Gmail, Dropbox Team Up

https://blogs.dropbox.com/dropbox/2018/07/gmail-add-on/
https://gsuite.google.com/marketplace/app/dropbox_for_gmail/33761876029


PCLinuxOS Magazine Page 16

about using the Dropbox add-on in Gmail will be that you won’t have to worry
about file size restrictions for your attachments. That is something you will have
to worry about when attaching files in the normal fashion. With the Dropbox add-
on in Gmail, you’ll be able to get a link to your file (stored in your Dropbox
account) and just share the link.

You could do that now, but you’d have to first open your Dropbox account, find
the file, copy the link, and then paste that link into your Gmail compose message
window. Once the service expands later this year, that whole process should be
streamlined considerably by the Dropbox add-on for Gmail. When it rolls out, you
should be able to get the Dropbox link to any file stored in your Dropbox from
right within the Gmail compose message window.

So, once its fully functional, it will eliminate the need to switch between two
services or apps just to share a link to a user’s Dropbox file. Instead, it will all be
available from within Gmail. The add-on works on PCs (including mine, running
PCLinuxOS), as well as the Android and iOS platforms.

Gmail, Dropbox Team Up

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!

http://pclosmag.com/special.html
http://pclinuxoshelp.com/index.php/Main_Page
http://www.fsf.org
https://www.imagemagick.org/script/color.php
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Screenshot ShowcaseScreenshot Showcase

Linux Training
Courses & Classes

Users Don't

Text
Phone

Web Surf
Facebook

Tweet
Instagram

Video
Take Pictures

Email
Chat

While Driving.

Put Down Your
Phone & Arrive Alive.

Posted by coffeetime, on August 3, 2018, running e17.

http://chimpbox.us
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As told by YouCanToo

What is your name/username?
My name is Anton. Most people call me Tony,
though. The username is duskull, a digital creature
that I adore since my childhood.

How old are you?
I'm 26, and pretty happy that I'm still young.

Are you married, single?
I'm single for now, still waiting to meet my significant
other one day. Patience is the key.

Do you have pets, what is your favorite?
I'm absolutely in love with cats, all of them. I had a
cat as a pet at home, but she died recently. Her
name was Ed. She was a very loyal and very cute
cat. I also love to feed and play with cats on the
streets (because we have many here in Bulgaria). I

try to help in any way I can so that cats feel
comfortable and happy. My dream is to see more
organizations taking care of homeless cats so that
more people can own them as pets and streets won't
be so full with cats.

Are you retired, stil l working and if working, what
do you do?
I work as a receptionist in a hotel, which is located
around a small town called Tsarevo, located at the
Black Sea Coast. I love my job for many reasons,
like meeting many people from all around the globe,
learning different languages, making people feel
happy, having enough free time to go to the beach
(and being close to it), having access to cutting edge
hardware and some others. While this is my main
job, from time to time I help a good friend of mine
repair computers, reinstall operating systems and
creating small networks. My dream is to move to the
IT sector soon. That's is my true passion, and I see a
good future for it.

Where do you call home? What is it l ike? IE:
weather, scenery
I'm from Bulgaria and I live in Burgas, the fourth
biggest city in Bulgaria. Some say that this is the
best city for living in my country, and I personally
believe that.

The weather here is rather warm the whole year
(from -4 to 40 °C). In the winter, the wind is very
strong, but snow is very rare to see. We do have
beautiful mountains, beaches, forests and rivers. I'm
including some photos of the places I like.

Where did you go to school and what is your
education level?
I finished university in Burgas, tourism profile. Since
then, I did a course about Linux System
Administration, and I’m planning to do Cisco
Networking next.

Tsarevo Villa Zone Sveti Vlas Resort

View from my balcony

Black Sea Coast

PCLinuxOS Family Member Spotlight: duskull
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What kind of things you like doing? hobbies,
travel, fishing, camping?
In my free time I like tinkering with electronics at
home (Raspberry Pi, Odroid), listening to music and
reading books from time to time (be it digital or on
paper). I like 8-bit retro games and (MMO)RPG
games. When it comes to outdoor activities, I like to
explore caves, mountains and deep forests. In the
summer I try to go to beach as often as possible, I
enjoy swimming and diving activities.

Why and when did you start using Linux?
My first encounter with Linux was in 2009, where I
first met Xandros Linux. It was preinstalled on my
Asus EEEPC 901. I remember that I was in a hurry
replacing it with Win XP (7 was just too much for it),
so I can run my favorite software freely. After a few
months of using XP and trying to optimize it for
speed and lightness, I decided to give Linux a try.
After not much reading on the net, I met Slax Linux,
my first official Linux distro. At first, I was only using
it with a USB stick, so that I can keep my other OS
and data. I was impressed that Linux could read
both Linux and Windows partitions, not to mention
the huge choice of open source software available.
After realizing how open Linux is, I started to play
with different DE's so that I could lower memory
usage even more (just imagine how I felt with just
512MB of RAM). Because Slax is a portable distro I
decided to remove Windows completely and give
Debian a try, and it was my main OS for the next two
years. Nowadays, I like to test almost every distro
out there, as soon as it gets a new release (be it on
bare metal or VirtualBox), but my main distro is
PCLinuxOS.

What specific equipment do currently use with
PCLOS?
I'm a fan of Dell machines. My main PC is a Dell
Latitude E6500, while my travel machine is a
Samsung N145P netbook.

Do you feel that your use of Linux influences the
reactions you receive from your computer peers
or family? If so, how?
Well, the answer here is centrally yes. Often many
people ask me "what's this version of Windows?" or
"is that Mac or something?". I'm used to it, and it
even makes me happy. I'm always open to share my
knowledge about Linux with everyone, and I can
proudly say that some of my friends are using Linux
because of me. I'm trying my best to help the
community to grow. Still, sometimes I'm facing the
compatibility factor from which some many people
are scared. They just want to stick with Windows, no
matter what (games, business software). I live with
the idea that better days will come. Linux may be
able to beat Windows in some countries, including
mine. And about family - of course they use Linux,
again because of me.

What would you like to see happen within
PCLOS that would make it a better place. What
are your feelings?
It must stay systemd-free, independent and up to
date. I see a good future for it, but it is important that
the community stays strong and tight. It will be
always be that different distro that has its unique
features and tries to be friendly. My personal opinion
is that some improvements are needed regarding
the PCLinuxOS Control Center - more options,
better look and feel. Everything else is great.

PCLinuxOS Family Member Spotlight is an exclusive,
monthly column by YouCanToo, featuring PCLinuxOS
forum member. This column will allow "the rest of us" to
get to know our forum family members better, and will
give those featured an opportunity to share their
PCLinuxOS story with the rest of the world.

If you would like to be featured in PCLinuxOS Family
Member Spotlight, please send a private message to
youcantoo, parnote or Meemaw in the PCLinuxOS forum
expressing your interest.

Support PCLinuxOS! Get Your Official

PCLinuxOS
Merchandise Today!

PCLinuxOS Family Member Spotlight: duskull

http://www.linuxfoundation.org/
http://www.cafepress.com/pclinuxos
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by Meemaw

Everyone takes vacation photos, and I’m sure yours
are wonderful. We’ve seen some really great photos
in the forum as well, and I’m sure that yours are
among some of the great ones. If you don’t think
they are, and you’re wondering how to make
improvements to some of them, I’m going to show
you a few things you might do to make your photos
“pop.”

In the July, 2015 issue I did a short tutorial about
editing photos. This one expands on that a bit and
gives you more choices. In the earlier tutorial, I used
a photo I took at Monument Valley in southeast
Utah. I’m going to use a different one this time. This
one was taken in Colorado from an ATV trail.

The first thing you can do is adjust the Levels. Click
on Colors > Levels and you’ll get the histogram
showing the color graph (center, top).

As you can see there is a low spot on each end of
the histogram. Start by moving the arrows

underneath the histogram inwards towards the spot
where the curve starts extending upwards. This
helps to even out the light and dark areas of the
picture. Then, move the center arrow left or right
until you are satisfied with the result. This changes
the midtones. If you will check “Split view” at lower
right, you can see the changes in the left half of the
picture with the photo’s original appearance on the
right half.

That has brightened up the colors a bit.

The next thing we want to do is edit again using
Colors > Curves. When the window opens, you will
see the histogram again, but it doesn’t look quite the
same because you’ve already edited a bit. On top of
the histogram is a straight line from bottom left to top
right. You can use this line to fine tune the areas of
your photo. Pulling down on this line will darken
things and pushing up on it will lighten things.
Depending on which end of the line you move and
which way you move it, you can change the
darkness and lightness more than you would if you
quit at editing levels. Also, when you click on the
line, it will create a node which will stay when you
release it. Now you can click elsewhere and move
your line again to edit other aspects of your photo.
Lightening dark areas and darkening light areas may
improve your photo greatly. (Check “Split view” to
see what’s happening.)

As you can see, my line ended up as an “S” shaped
curve. My photo looks a bit better, too.

GIMP Tutorial: Editing Your Vacation Photos

https://pclosmag.com/html/Issues/201507/page05.html
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The next thing you can do is adjust any color you
think shouldn’t be there. This uses Colors > Color
Balance.

In this one, you can edit three different ranges:
Shadows, Midtones and Highlights. You might
have to study your photo to see if your colors are the
way you want them. This is especially helpful if you
think your photo is too red or green (or if your photo
is old and has turned that reddish brown that some
of them turn). Again, click “Split view” to see what
you are doing.

I wanted just a little more green in my photo, so I
increased the green.

Saturation is the intensity of the color in your photo.
If you click Colors > Saturation or Colors > Hue-
Saturation, you can adjust the colors so they are
more intense. If your photo is dull, this is one of the
best ways to enhance it. Using Saturation is easier
because there is only one slider, but to fine tune
things, you could use Hue-Saturation as there are
many different settings. If there is a certain color you
want to emphasize, you can do it there.

I used Hue-Saturation and set the saturation up to
30 (right, top).

One last thing you can do is use Sharpen or
Unsharp Mask to sharpen your photo, being careful
not to go too far, as your photo may end up with little
white halos on the edges of things. This is Unsharp
Mask that has been taken to excess:

Linux Docs
Linux Man Pages

GIMP Tutorial: Editing Your Vacation Photos

http://www.die.net/
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In an article I read, it was summarized as follows:

• Adjust the dark/bright Input Levels sliders relative
to the histogram edges to improve contrast. Adjust
the mid-tones slider to settle on the overall
brightness.
• Apply a subtle curve adjustment (Curves) to
enhance any areas along the brightness scale we're
still not happy with.
• If you think there's a nasty tinge to your image,
balance it out using the Color Balance tool.
• Increase the master saturation and also adjust the
Saturation for any other colors you want to
emphasise further (or de-emphasise).
• Apply some Sharpening, being careful not to
make edges look too 'spikey'.

My mountain photo looks better, in my opinion.

It might be too green for you, but as I remember the
trip, everything was very green and lush.

Oh, my Monument Valley photo from the last article?
I did it again and I think it looks even better. I’ll show
both so you can compare.

Before

After

I can tell you that when you are there, the colors are
vibrant like in the second photo.

Following these steps has helped me immensely! I
hope they help you edit your photos like they helped
me. Your photos will look awesome, too!

By the way, we have a new version of GIMP as well,
version 2.10.6. Some people have told me that while

editing photos, their systems have slowed down a
lot. While it hasn’t happened to me, you could
experience some slowdowns. Some of it also
depends on your system capabilities (memory,
CPU), the size of your photo (bigger takes longer
and uses more resources), and what steps you are
performing. If you are just cropping your photo or
resizing it, you should be fine, but if you are using
some heavier filters, it may take a while. Also, the
status bar shows a completely different number than
your image size: it shows the amount of system
memory used by your image. I was working on an
image that had a file size of 2MB, but the status bar
showed 47MB! That’s the memory my system is
using while I edit the photo. I’m sure if the GIMP
developers get complaints, they will address it
quickly. I know there have already been a couple of
posts on our forum. Hang in there, guys, I know
they’ll fix it.

Are viruses,
adware, malware &
spyware slowing
you down?

Get your PC back
to good health
TODAY!

Get

Does your computer run slow?

Are you tired of all the "Blue Screens
of Death" computer crashes?

Download your copy today! FREE!

GIMP Tutorial: Editing Your Vacation Photos

http://www.dosgamesarchive.com/
http://www.pclinuxos.com/?page_id=10
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Screenshot ShowcaseScreenshot Showcase

Posted by parnote, on August 18, 2018, running Xfce.
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http://pclinuxos.fi/
http://www.pclinuxosbrasil.com.br/
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PCLOS with you I'm staying never will I go a straying
You're the one that I've been praying for

Downloading you without delaying always free no more paying
PCLOS you I adore

They said that I would never find the OS of my dreams
But now I have you and proved them wrong so it seems

Downloading you without delaying always free no more paying
PCLOS you I adore

To no other distro I am bowing not a one am I allowing
No distro hopping anymore

All my time with you I'm vowing me you are always wowing
PCLOS sending you love galore

They said that I would never find the OS of my dreams
But now I have you and proved them wrong so it seems

All my time with you I'm vowing me you are always wowing
PCLOS sending you love galore

I never thought I would find
An OS I would admire

Tried them all but none of them
I did desire

Through all the net I grubbed and groped
But nothing set me afire

Then found one with a forum of fun
From searching I retire

ms_meme's Nook: The OS OfMy Dreams

MP3 OGG

http://pclosmag.com/html/Issues/201809/files/theosofmydreams.mp3
http://pclosmag.com/html/Issues/201809/files/theosofmydreams.ogg
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by Alessandro Ebersol (Agent Smith)

Speech recognition is one of the most interesting
aspects of computing. Great strides have been
made in recent years. These advances have been
passed on to personal computing. That is, what was
achieved with Research on voice recognition
technology, reached the home users.

Speech recognition is a feature that can be used to
improve accessibility, or even when you're tired of
typing very large texts. Yes, being able to rest your
hands after entering many texts is extremely
comfortable.

Users of other operating systems can enjoy voice
recognition easily. In Windows there is Dragon
Naturally Speaking. On Mac, Dictanote and WordQ
SpeakQ. But what about Linux?

In Linux, we have several mechanisms of speech
recognition. However, usually they are extremely
complicated to make work. Generally, these are
solutions that need pocketsphinx, which is a speech-
recognition and text-to-speech engine.

But do not be afraid, because voice recognition
technology has come a long way thanks to Google
(now the Alphabet Company), and we, PCLinuxOS

users, can take advantage of these benefits from the
largest Internet search engine.

The Google Voice Voice Recognition
Infrastructure, Google cloud voice API

Google has unveiled its new Cloud Speech API -
announced at the NEXT event in San Francisco - for
a limited preview for developers in 2016. This
speech recognition technology has been developed
and has already been used by various Google
products for some time, such as Google's search
engine, where you have the option to do voice
search.

The ability to convert speech to text is based on
deep neural networks, and state-of-the-art machine
learning algorithms have recently proven to be
particularly effective for detecting patterns in audio
and video signals. The neural network is updated as
new speech samples are collected by Google, so
that new terms are learned and recognition accuracy
continues to increase. This technology from Google
is what powers Ok Google, Android, Google Chrome
and Google Virtual Assistant. With its cloud-based
speech recognition technology, Google intends to
rival Nuance, maker of the old Windows Dragon
Dictate (now Dragon Naturally Speaking).

Voice recognition in the cloud

Speech-to-text features are used in a variety of
cases, including smart wizards controlled by voice
on mobile devices, home automation, audio
transcription, and automatic classification of phone
calls.

Now that this technology will be accessible as a
developer’s cloud service, it will allow any
application to integrate speech recognition into text,
representing a valuable alternative to the common
Nuance technology (used by Apple's Siri and
Samsung's S-Voice, for example) and challenging
other solutions such as the IBM Watson Speech to
Text and the Microsoft Bing Speech API.

Now, how do we benefit from Google Voice
Cloud Recognition?

It is possible to enjoy the advantages that Google
integrates with its products, since several sites offer
the service of voice recognition, through the Google
cloud voice API.

To take advantage of these services, you will need
an internet connection, a microphone attached to
your computer, and use the Google Chrome
browser. The following is the analysis of some of
these services.

https://speechnotes.co

Speechnotes is a powerful, speech-enabled online
notepad designed to empower your ideas by
implementing a clean and efficient design so you
can focus on your thoughts. The website staff strives
to provide the best online dictation tool, involving
state-of-the-art speech recognition technology for
the most accurate results technology can achieve
today, as well as incorporating internal (automatic or

Easy Voice Recognition In PCLinuxOS

https://speechnotes.co
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manual) tools to increase efficiency, productivity and
user comfort. It works totally online on your Chrome
browser. No download, no installation and no
registration required, you can start working
immediately.

My rating: It supports Brazilian Portuguese and more
than 40 languages, saves to Google drive, and if you
subscribe to the service of the company, you can
access your documents from any machine logged
into your account. I've used it, and voice recognition
is fast and accurate. It works on Google Chrome and
with cell phones too.

https://www.speechtexter.com/

SpeechTexter is a professional online speech to text
converter designed to simplify and speed up your
work. The company wants to provide the best online
transcription experience using innovative speech
recognition technology with high precision results.
This technology is only supported by the Chrome
browser for computers. Other browsers have not yet
implemented speech recognition. No registration is
required, so you can get to work immediately.

My rating: Supports Brazilian Portuguese and more
than 40 languages, saves as TXT, prints or copies to
the clipboard. It has no registration, so that means it
can only be used on one machine at a time. In my
tests, it was a bit slower than Speechnotes.

https://www.textfromtospeech.com

This utility is a text to speech/speech to text service.
What does that mean? This means that you can
simply dictate text, and it will be written without lifting
a finger. On the other hand, you can type text and
the service provided by site will read it loud.

You have the following features:
• Free and online
• No download, installation or registration.

Multiplatform
• Supports only 7 languages ​​(and Brazilian

Portuguese is not one of them)
• You can pause or stop dictation (it saves the

position of the last word)
• Recognizes voice commands to enter punctuation:

for example, say "Comma" and type ","
• Smart capitalization
• You can save, copy, print, or send dictation text.

My rating: Since it does not support Brazilian
Portuguese, I have not tested it. But, it seems to be
the service with fewer resources among those
evaluated.

https://dictation.io/

Dictation.io can recognize and transcribe popular
languages, including English, Spanish, French,
Italian, Portuguese, and more. The full list of
supported languages ​​can be checked here:
https://dictation.io/languages You can add new
paragraphs, punctuation marks, smileys and other
special characters using simple voice commands.
For example, say "New line" to move the cursor to
the next list or say "Smiley Face" to enter smiley :-).
It has a list of supported commands.

My rating: Allows to perform several actions with the
text that was recognized: Copy to the clipboard,
save as .TXT, send as Tweet, send by email, print or
export as PDF, or have the computer dictate the text
you dictated previously. In terms of speed, it
resembles Speechnotes.

Thus, there are even more options than these four
analyzed, but would require more research time for
their analyzes. What matters is that if you need to
dictate lengthy texts, PCLinuxOS can help you
accomplish the task. Regarding speech recognition,
Linux is no longer a second-class citizen.

I hope you enjoyed it, and, this text was produced
with the help of Speechnotes and, edited in
LibreOffice later.

Enjoy these new capabilities, and see you next
month! Look ma! I entered text with no hands!

Donate NOW

Easy Voice Recognition In PCLinuxOS

Linux Training
Courses & Classes

http://www.gofundme.com/pclinuxos-2016
https://www.speechtexter.com/
https://www.textfromtospeech.com
https://dictation.io/
https://dictation.io/languages
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by Jeane

If it isn't the friendliest community in the whole linux
land, huh? Hi there! [My] name's Jeane, after going
through many, many, many distros. There has
always been one who would be like "Oh this works
great … then I find it does this, and it kinda breaks
down the experience," be it the resolution, be it the
xorg config, be it the drivers, be it that I plugged in
something and my PC would start to do weird
sounds, etc.

PCLinuxOS, on the other hand, never gave me any
trouble on my main PC at all. In fact, it was quite …
boring. A little tedious when changing languages, but
otherwise, everything worked well! Resolution was
an easy fix. I could choose the updates and
packages I could upgrade, without W10 forcing it
down my throat. It is stable, and it always ran well on
my systems.

Admittedly I am bit skeptical when it comes to rolling
releases, since I [would] rather maintain something
stable over things that break. But, I know the
packagers of this place do a great job at keeping
that everything is in order, and it gives me a peace
of mind the likes no others.

I am aware of the current situation with Tex, and I
hope he is able to recover from cancer. He is the
rare example of someone who consistently
maintains and improves a distribution that has stood
stable, and with no forceful changes. [This is] in
opposition to many, many distros that have taken
brand changes, went on a complete tangent and
related (Tex is kind of like Volkerding but with a
different mindset).

Well I am here now! Hopefully, you don't mind
someone under 20 to join the ranks. (Hope there's
also young people in here!)

A Vote Of Appreciation
by Treedragon

So I have been using PClinuxOS for quite a few
years now, since version .92 from around late 2003.
I was a late starter in the computer world debuting
with Windows 98, and learned how by pressing the
Start button and making mistakes, fascinated by it
but not impressed….. I started to fiddle with things
especially the visual aspect and also discovered the
world of “free” software but…… well yes, it was
Windblows based and somehow all over the
place……..

Then I tried Xandros briefly which, after reading
between the lines here and there, led to PClinuxOS

because in total the feel of it all it was and is, just
simply right.

So for many years now I have been a quiet
participant of the PCLOS world pursuing a personal
flow of what I chose in looks, rootling through the
software offered, learning at least just a little in what
feels like a one step forward two steps back sort of
way and knowing that it would just work. Sure very
occasionally there were glitches and then there
weren’t, they were just fixed, sorted, dealt to, and
the flow continued.

A flow I don’t doubt that allowed so many to pursue
their computer vision/experience with an OS that
could be counted on. I and so many others just
know that it will work especially with the help of the
family, the forum members, willing to help if there
were issues. What is most magical of all to my mind
and sense of being, is how one person's
dream/vision/ and maybe a touch of “Nah! stuff that,
I’m doing it this way” (sort of thing)…... has created
such a rare beast of immense value.

To this eye anyway, it is an aspect of much valued
expression to individuality that by it’s focus of
purpose alloyed with strivings of quality and
commitment that is a lesson to some of us. All this
despite those times when that drive may have been
a bit thin on the ground with degrees of angst and
thoughts of “I’m to old for this sh**”. Provision of an
OS that allows for others to express themselves,
built with degrees of dedication in the process all the
while drawing in a community that simply astounds
in this day and age of…………. well the less than an
ideal from some viewpoints.

Soooo……... these words they are a Thank You to
Bill Reynolds, your helpers and the ongoing dream,
and maybe also just a reminder to self what a

Testimonials: Hello There!, A Vote Of Appreciation
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blessing it is to have an important aspect of daily life
that simply just works, and as the advert says “It’s
Priceless”. There are very few days going by that I
don’t give thanks for Bill’s creation.

THANK YOU.

Screenshot ShowcaseScreenshot Showcase

Donate To PCLinuxOS

Community Supported.
No Billionaires/Millionaires.

No Corporate Backing Or Funding.

Click here to make a one-time donation
through Google Checkout.

Or, click one of the amounts down below
to make a monthly, recurring donation.

Linux Training
Courses & Classes

Posted by jpgurtmen, on August 27, 2018, running Mate.

Testimonials: Hello There! , A Vote Of Appreciation

http://www.pclosusers.com/services-signup.php
http://www.pclinuxos.com/?page_id=7
https://gumroad.com/pclinuxos#LXoq
https://gumroad.com/pclinuxos#FGqC
https://gumroad.com/pclinuxos#zpNB
https://gumroad.com/pclinuxos#MPxaN
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by Paul Arnote (parnote)

One of the “heavyweight” programs available on Windows and MacOS is Adobe’s
Photoshop. In fact, most of us have met people who refuse to migrate to Linux
because it would mean losing their ability to use Photoshop, since Photoshop is
generally not available to Linux users. Their “attachment” to Photoshop is
somewhere up there with their attachments to breathing, eating, drinking and
having a pulse.

Never mind that most Linux distributions have one of the most powerful graphics
tools available for installation (or, in a lot of cases, preinstalled) with GIMP. Their
argument is that it isn’t Photoshop. Yes, GIMP is different from Photoshop, and as
such, it works differently than Photoshop. But, you can perform the vast majority
of graphical tasks in GIMP that you can perform in Photoshop … if you know
how. These people have learned the Photoshop way (no, they didn’t come out of
the womb knowing how the “Photoshop Way”), and they refuse to take the time to
learn a new method … the GIMP way.

On top of that, the last “full” version of Adobe Photoshop will set you back $700
(U.S. dollars, MSRP), and a cool $1,000 for the “extended” version. That would
be for Adobe Photoshop CS6. But that was released in May, 2012. It is no longer
supported, and there are no further updates (security or otherwise) available for
it.

Starting in 2013, Adobe Photoshop switched to a “subscription” based plan
where, just like your rent, you pay a monthly fee to continue to use your copy of
Adobe Photoshop (there is an annual subscription, but there is no discount for
paying for a year at a time … just take the monthly fee and multiply it by 12). The
designation changed from CS to CC, which stands for “Creative Cloud.”

Today, most users who want a fully capable and installable version of Photoshop
opt for the trimmed down Photoshop Elements. In the process, they save
themselves over $500, as Photoshop Elements can be obtained for under $100,
in many cases. And, for most users other than graphic artists, Photoshop
Elements is more than powerful enough for their use.

Photoshop Elements can use all of the Photoshop 8bf filter plugins (and there are
a ton of them), and most limitations of Photoshop Elements, when compared with
the full version of Photoshop, can usually be worked around by familiarizing
yourself with the many Photoshop tutorials available on the internet. If you’re
interested, here’s a good place to start. This isn’t, by far, an exhaustive list of
available Photoshop tutorials. There are also some GIMP tutorials mixed in at the
aforementioned link (such as this one … and there are other ones), but most
target Photoshop users. Some tutorials are very general in nature (related to
graphics editing, such as this one, or this one … there are many others, too.),
and may be applied to any program.

But still, even Adobe’s Photoshop Elements isn’t supported on Linux, as there is
no Linux version. What if there was a way that Photoshop’s diehard fans could
switch to Linux but not lose access to their favorite graphics editor? Wouldn’t that
tear down the barrier that these users have for switching to the infinitely more
secure and stable Linux?

Photopea: A Photoshop Replacement?

http://chimpbox.us
https://www.newegg.com/Product/Product.aspx?Item=N82E16832505509&cm_re=photoshop_elements-_-32-505-509-_-Product
https://www.lifewire.com/learn-how-graphic-design-4160665
https://www.lifewire.com/add-a-graphic-watermark-in-gimp-1701704
https://www.lifewire.com/what-color-is-indigo-1077388
https://www.lifewire.com/turquoise-design-colors-1077401


PCLinuxOS Magazine Page 30

Enter Photopea

You may not believe this, but Photopea aims to be an online web application
that will serve as a replacement not only for Photoshop, but also GIMP and
Sketch. Talk about ambitious! The project is hosted on GitHub. As a webapp, this
means that even Chromebook users will have access to a potentially powerful
graphics editor.

Above is the Photopea work canvas when you first visit the site. Truthfully, it looks
an awful lot like Photoshop. From here, you can start a new project, open an
image file stored on your computer, or view a demo on how Photopea works.

In the screen capture above, I’ve loaded in an image from my computer. From
here, it’s ready for editing, using the tools along the left side of the webapp
window.

Clicking on the red “Account” button in the webapp’s menu bar, you get another
window that opens, detailing the plans. Yes, Photopea is free, and appears to be
fully functional. You can “elevate” your Photopea from “free” to “premium” by
paying either $9 per month, or $20 every three months. Premium members get to
use Photopea ad-free, and get to help improve Photopea. Since I run uBlock
Origin as my ad blocker, I have yet to see an ad on the Photopea page.

Photopea: A Photoshop Replacement?

https://www.photopea.com/
https://github.com/photopea/photopea


PCLinuxOS Magazine Page 31

It’s nice that Photopea is able to open not only Photoshop PSD files, but also
native GIMP XCF files and SKETCH files from SketchUp. This will make
Photopea invaluable, since you won’t have to have versions of each program
installed on your computer. I can’t tell you how many times I’ve run across files
(drawings and schematics) created in SketchUp, only to find that I didn’t have the
necessary software to open the SKETCH files.

As functional as it might be, Photopea does look like a “work in progress.” But it
does seem to be, nonetheless, functional. When I loaded an image into the
workspace canvas, the only filter that appeared to be available to me was
“Liquify,” and clicking on it didn’t seem to do anything to my image.

However, everything is not as it initially seems. The menus in Photopea open and
appear very short … that is, until or unless you close the top part of the window
shown in the first Photopea graphic. So, to see all the options, you have to close
that top part of the window (click on the large “X” at the top right), or otherwise
you have to scroll through the list of available options with the scroll wheel of your
mouse. This “feature” was not immediately evident to me, and it wasn’t until
Meemaw pointed it out to me that I “discovered” the other menu items that were
available. To be honest, I never closed out the top part of that window. Similarly,
and just as “saving” a file in GIMP saves the image as a GIMP XCF file, just
saving an image will save the file as a Photoshop PSD file. You have to go to the
“File” menu, and select “Export” to be able save the image as a PNG, JPG or
SVG file. In the interest of full disclosure, I only tried Photopea in the Firefox
Quantum web browser.

Summary

I didn’t explore Photopea deeply. I am not now, nor have I ever been, a
Photoshop user. That was one piece of software priced way out of my reach,
regardless of how much I desired to use it. It remains that way, to this day. Of
course, I’m a Linux user now, so running Photoshop isn’t even a possibility for
me, anyways. The closest I ever came to Photoshop was the old (and much more
affordable) JASC’s Paint Shop Pro, which (by the way) was able to utilize some
Photoshop 8bf filter files. (On a side note, and just for grins and giggles, JASC
stood for “Just Another Software Company.”)

As such, I’m not at all versed in the “ins and outs” of using Photoshop. Anything I
would have been able to do in Photopea would be basic graphic tasks, like
cropping an image, adding text, adjusting brightness and contrast, etc. Of course,
I also sometimes struggle with complex tasks in GIMP, unlike our Assistant Editor
Meemaw, who is at least two or three leagues above me with her GIMP abilities.

For many users, Photoshop was way out of their price range. Just purchasing
Photoshop alone wasn’t the end of your cash expenditures, either. There are a
LOT of third party 8bf filter files, and you could spend a small fortune on buying
them alone. With Photoshop, a lot of people got a “piece of the pie” from software
purchasers.

Photoshop users, however, may be intrigued enough to follow Photopea’s
development. Having another graphic editor available and at your fingertips is
never a bad thing. Even on Linux, I sometimes use other graphics editors over
GIMP. Some tasks just seem to be too simple and small to launch GIMP, and can
be done more easily and with less overhead by using a smaller, simpler graphics
editor.

I do wish that the GIMP developers would make it possible to use the Photoshop
8bf filter files. That alone would add a whole level of attraction to GIMP that would
be hard for some Photoshop users to overlook. Since JASC once added such
support to Paint Shop Pro, I do wonder why the GIMP developers have never
done so, and it’s a question that I have asked myself many times over. As it is
now, GIMP scripts are difficult to write – at least from where I sit.

Perhaps Photopea will develop to the point where there are a LOT more filters
that at least mirror the functionality of the famous/infamous Photoshop 8bf filter
files. If that happens, then Photopea will be a very powerful tool in any user’s
toolbox of graphical utilities.

Photopea: A Photoshop Replacement?

http://www.linuxfoundation.org/
https://en.wikipedia.org/wiki/Jasc_Software
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INGREDIENTS:

1 pound lean ground beef
1 small onion, chopped (1/4 cup)
1 1/3 cups hot water
1 cup Chunky salsa
1/2 cup milk
1 package Hamburger Helper™

cheeseburger macaroni
6 Flour tortillas, 6 inch
1 1/2 cups shredded Cheddar cheese (6 oz)

DIRECTIONS:

1. Heat oven to 350F. Cook beef and onion in 10-
inch skillet over medium-high heat, stirring
occasionally, until brown; drain. Stir in hot water,
salsa, milk, uncooked Pasta and Sauce Mix. Heat to
boiling, stirring occasionally. Reduce heat; cover and
simmer about 7 minutes, stirring occasionally, until
pasta is tender.

2. Cut tortillas in half. Spread 2 cups beef mixture in
ungreased rectangular baking dish, 11 x 7 x 1 1/2
inches, or shallow 2-quart casserole; top with 6
tortilla halves and 3/4 cup cheese. Spread with 2
cups beef mixture; top with remaining tortilla halves.
Top with remaining beef mixture and cheese.

3. Bake uncovered 15 to 20 minutes or until hot and
cheese is melted.

TIPS:

Store leftover tortillas in a resealable plastic food-
storage bag or in plastic wrap in the refrigerator.

Like it hot? Use hot salsa and shredded Monterey
Jack cheese with jalapeño peppers.

Co n n e c t connections in one
convenient location!

All your
PCLinuxOS

PCLinuxOS Bonus Recipe Corner

Tortilla Casserole

http://pclosmag.com/links.html
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Posted by Mr. Cranky Pants_YouCanToo, on August 18, 2018, running KDE.

http://pclinuxoshelp.com/index.php/Main_Page
http://pclostalk.pclosusers.com
http://pclinuxos.com/?page_id=188
http://pclinuxos.com/?page_id=7
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by CgBoy

The desktop client for Bitwarden was recently added
to the repository, so I thought I’d write an article
about it. Bitwarden is an open source, online cloud-
based password management service. There are
native clients for Linux, Windows, macOS, Android
and iOS, as well as plugins for a variety of popular
web browsers. There is also a completely web-
based vault. However, for this review I’ll be focusing
on the Linux desktop client.

As I mentioned, it is entirely cloud-based, so the
password database is stored on cloud servers. The
password entries are encrypted before they’re even
sent from your computer to the cloud servers.
Bitwarden uses AES 256 bit encryption and PBKDF2
for encrypting the data.

Although Bitwarden is open source, there’s an
optional $10.00 per year Premium membership. This
offers 1GB of encrypted file storage ($4.00 per extra
GB a year), more options for two-step login, and
priority customer support. But for this review I just
used a free account, so I can’t comment on those
extra features.

The interface has a very modern and clean look to it.
On the left side of the program is where you can
choose to display all the entries, favorite entries,
certain types of entries, or entries stored in specific
folders. The password entries themselves are listed
in the middle of the program, with a search box. On
the right side is where you view and edit the
contents of the currently selected entry (center, top).

You can use Bitwarden to store normal login
usernames and passwords (which is what most
people will use it for), credit card information, identity
information, and secure notes. Adding a new entry is
really quick and easy.

All types of entries can be assigned to folders, and
can have notes and custom fields attached.

Bitwarden also comes with a handy random
password generator. You can set how long the
generated password will be, and what types of
characters to include. When you’ve chosen a
password, Bitwarden can check it against a known
passwords database to see if it’s been exposed
before.

Bitwarden supports two-step login using an
authenticator app, YubiKey (premium account only),
Duo Security (premium account only), FIDO U2F
(premium account only), or through email. Two-step
login has to be set up from the web vault. And make
sure not to lose your recovery code just in case!

Repo Review: Bitwarden
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If you’ve been using a different password manager
and now switched to Bitwarden, you can import
password databases from a variety of popular
password managers such as LastPass, KeePass 2,
KeePassX, 1Password, and many more. However,
password databases can’t be imported from the
desktop client, you have to use the web vault.

If you don’t like the idea of your passwords being
stored in the cloud, you can actually host your own
Bitwarden server. I did not have the time to try out
this feature, but there’s plenty of documentation
available on their website.

Another feature I didn’t have time to try out was
Organizations. According to the Bitwarden website
“A Bitwarden organization is an entity that relates
users together that want to share logins. An
organization could be a family, team, company, or
any other type of group that desires to share logins
in Bitwarden.”, but like I said, I didn’t have time to try
it out.

Summary

Compared to other password managers I’ve tried, I
found Bitwarden fast and easy to use. I have to say
that I’m not really a huge fan of Bitwarden being
cloud-based, but I’m sure it makes it much easier to
sync with multiple devices. While I myself don’t
actually use any password managers outside of the
one built into my web browser, I would recommend
Bitwarden to anyone looking for a good free, cross-
platform password manager.

Screenshot ShowcaseScreenshot Showcase
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Mate Desktop

Posted by OnlyHuman, on August 3, 2018, running e23.

Repo Review: Bitwarden

http://www.pclinuxos.com
http://www.linuxquestions.org
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I wanna tell you a story about a Texan named Texstar
Everyone in the tech world was sayin' he'd go far
Tex was workin' on Windows one hot day in July
When he sat down with a beer and began to cry

Well I ain't a gonna take this mighty mess no more
Tex went on line to find a Linux brochure
Designin' and refinin' makin' the very best

Texstar created PCLinuxOS

Fans come to the forum to meet greet 'n mix
They love downloadin' all his Linux tricks

I been a singin' ten years for the forum crowd
'Bout Texstar and how we are so proud

PCLinuxOS has given happy years
Tip your hat to Tex give him one hundred cheers

ms_meme's Nook: One Hundred Cheers

MP3 OGG

http://pclosmag.com/html/Issues/201809/files/onehundredcheers.mp3
http://pclosmag.com/html/Issues/201809/files/onehundredcheers.ogg
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Editor’s Note: Tip Top Tips is a semi-monthly column in The PCLinuxOS Magazine.
Periodically, we will feature – and possibly even expand upon – one tip from the
PCLinuxOS forum. The magazine will not accept independent tip submissions specifically
intended for inclusion in the Tip Top Tips column. Rather, if you have a tip, share it in the
PCLinuxOS forum’s “Tips & Tricks” section. Your tip just may be selected for publication
in The PCLinuxOS Magazine.

This month’s tip comes from davecs.

I keep reading "reviews" on Ebay and Amazon UK that British people are buying
keyboards online, only to find that they are American. The main problem they
have is that the keyboard does not have a Sterling sign (£) on it, the quotedbl (")
and at sign (@) are swapped over. The key that produces hash and tilde has
backslash and pipe on it, backslash and pipe are no longer available, as there is
one key less on the US keyboard! Everything will appear in the same place on
the keyboard as they did before, but the legends on the keys are wrong.

If you switch to the US keyboard layout, everything will match up to what is on the
keyboard, but you won't have access to a £-sign. So what to do?

There is a directory, /usr/share/X11/xkb/symbols/, that holds many keyboard
maps, and the British one is "gb". If you look at it, you will see a number of
sections. The first one is "default", and looks like this:

// based on a keyboard map from an ' xkb/symbols/gb' file

default partial alphanumeric_keys
xkb_symbols "basic" {

// Describes the differences between a very simple en_US
// keyboard and a very simple U. K. keyboard layout defined by
// the SVR4 European Language Supplement and sometimes also
// known as the IBM 166 layout.

include "latin"

name[Group1] ="English (UK) ";

key <AE02> { [ 2, quotedbl, twosuperior, oneeighth ] };
key <AE03> { [ 3, sterling, threesuperior, sterling ] };

key <AE04> { [ 4, dollar, EuroSign, onequarter ] };

key <AC11> { [apostrophe, at, dead_circumflex, dead_caron] };
key <TLDE> { [ grave, notsign, bar, bar ] };

key <BKSL> { [numbersign, asciitilde, dead_grave, dead_breve]
};

key <LSGT> { [ backslash, bar, bar, brokenbar ] };

include "level3(ralt_switch_multikey) "
};

Let me explain a few lines. The one that says include "latin", means that stuff is
read in from another file, called "latin", in the same folder. That's a generic
European key layout, which is basically the same as the American layout, but
with four symbols shown on many keys instead of two. You might want to look at
that file too.

Another very important line is include "level3(ralt_switch_multikey)". This
enables the Right-Alt (Alt-Gr) key to act as a shift to the third entry for each key,
and together with Shift, to access the fourth entry. So, we can fix the key moves
by deleting some of them. If we delete the entry for the "2" key, it will restore the
"latin" definition and put back the "@" sign. Deleting the keys <AC11>, <TLDE>
and <BKSL> will also put those keys back to the symbols on the keys. The key
<LSGT> isn't present on a US keyboard so we can delete that too. The "4" key is
left alone, so it will produce both "$" and "€". That leaves the "3" key. We need
the "£" on that which we can access through Alt-Gr. Best is to swap the third and
fourth positions on that key.

So your new layout will look like this:

// based on a keyboard map from an ' xkb/symbols/gb' file
// edited for UK on a US keyboard

default partial alphanumeric_keys
xkb_symbols "basic" {

// Describes the differences between a very simple en_US
// keyboard and a very simple U. K. keyboard layout defined by
// the SVR4 European Language Supplement and sometimes also
// known as the IBM 166 layout.

Tip Top Tips: British English On An
American Keyboard And Other Tweaks

http://www.pclinuxos.com/forum/index.php/topic,146427.msg1250426.html#msg1250426
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include "latin"

name[Group1] ="English (UK) ";

key <AE03> { [ 3, numbersign, sterling, threesuperior ] };
key <AE04> { [ 4, dollar, EuroSign, onequarter ] };

include "level3(ralt_switch_multikey) "
};

Don't edit the file in place, copy it somewhere else and edit it, and also keep a
copy of the original to put back in case of error. When you re-install, or
sometimes after an update, you will need to copy the file back over the top of the
"official" one.

Going through the "latin" file, you might not be happy with many of the defaults.
For example, Alt-Gr and q makes an @-sign, which is already on the keyboard.
So you might want to put in a line as follows:

key <AD01> { [ q, Q, infinity, Greek_OMEGA ] };

NOTE: Do not edit the "latin" file. This goes in the gb file. The less files edited the
better! Of course, there is nothing to stop you copying a line from the "latin" file,
pasting it into the gb file, then editing it. This will produce the infinity sign "∞" on
Alt-Gr q. You don't need to know the name of the key you want to substitute, you
can use the Unicode number (if 4 hex numbers) U221E, or for Unicode numbers
above FFFF, you can use 0x1 followed by the 6-hex figure code, so, the infinity
sign would be 0x100221E. You can redefine the third and fourth level keypresses
for a number of keys if you wish. I have!

Just remember to keep the original just in case, and to back up the edited version
so that you can restore it should the system overwrite it on an update.

Finally, if you're like me, you will have the CAPS LOCK key defined as the
compose key, for 2 reasons. One is to get a compose key, and the other is to
prevent you putting on CAPS LOCK in error. You can do this from the Control
Centre in KDE, but with other desktops you can't. To put it right in the "gb"
keyboard definition file, just add this line:

key <CAPS> { [ Multi_key ] };

Hope this helps someone!

----

Now that I have my keyboard, it is a mini- type and there are no keys for F11 and
F12. However, there are two keys I really don't need: NumLock and Pause/Break.
The thing is to go into BIOS and turn off startup numlock. Then into the PCLOS
Control Centre, and turn off the NumLock background service. Finally, into your
desktop settings and ensure that it turns NumLock off at startup.

Now set your keys in the "gb" file we discussed before:

key <NMLK> { [ F11 ] };
key <PAUS> { [ F12 ] };

Overall, the main section of the "gb" file will look like this:

// based on a keyboard map from an ' xkb/symbols/gb' file
// edited for UK on a US keyboard

default partial alphanumeric_keys
xkb_symbols "basic" {

// Describes the differences between a very simple en_US
// keyboard and a very simple U. K. keyboard layout defined by
// the SVR4 European Language Supplement and sometimes also
// known as the IBM 166 layout.

include "latin"

name[Group1] ="English (UK) ";

key <CAPS> { [ Multi_key ] };
key <NMLK> { [ F11 ] };
key <PAUS> { [ F12 ] };
key <AE03> { [ 3, numbersign, sterling,

threesuperior ] };
key <AE04> { [ 4, dollar, EuroSign,

onequarter ] };
key <AD01> { [ q, Q,

infinity, Greek_OMEGA ] };

include "level3(ralt_switch_multikey) "
};

And that, folks, is how Linux enables you to control your machine, and not the
other way around!

Tip Top Tips: British English On An American Keyboard And Other Tweaks
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D

o
w
n
lo
a
d
P
u
z
z
le
S
o
lu
ti
o
n
s
H
e
re

Possible score 286, average score 200.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/201809/files/2018-09-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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Acorn Anniversary

Apples Autumnal Equinox

Bales Baseball

Chestnuts Chilly

Cider Columbus Day

Corn Cranberries

Crops Deciduous

Equinox Falling leaves

Festival Field hockey

Football Frost

Grasshopper Harvest

Heater Indian summer

Jockey Katydid

Orchard Persimmons

Pine cones Pumpkins

Quilts Reunion

Scarecrows September

Soccer Squirrels

Tailgates Tourism

Tournament World Series

Download Puzzle Solutions Here

D L J I C W F R E M M U S N A I D N I B C P H A I O C S I V

T Y T E X S A O T E J S Y H B E A E J T U V G J C Z I C J A

M U N M Q L L L Z C N U O I E S G X Y M S R F Q H B B A S L

Z P E W C U L Q K T R O Q P B A V W P T T X V K P M A R B T

X B M I V E I W S W N U V F O T T K C L H S T U N T S E H C

Y W A P P N N N P C Q D M U Y O I E Z A J J O H F X G C K Q

T Q N H Z L G X O B U I S B V N C Q R K U Y I R V H W R T P

Z B R C S O L B P X N C I P S F Q V T S T P G J F R I O S B

I V U R L O E X C A R E R E Z J E D Y Z E A D X A R J W A U

K P O R U C A B V H O D U K N S I I X Y A P S Z Y B P S I J

Z A T T M V V F K N C T O Y T P U L X O Q W T G Q S S C H F

P T X Q E M E A O O A O T M T B Y C O M L Y M E T J K T O V

A L C Y S Q S D X I S G W R A P L Z N K D T E L M S G O V A

Y R A S R E V I N N A M Y E I X X S I Z K A I K Z B T C T U

V P C V W I I A X U M Y U R L R A A U S W U T V C B E C A T

O H O D I D I R X E O H C W G N M N Q O Q N G E A O W R G Q

S Q L W V T T F R R G D M I A D X X E C C C C L G O J B E A

Y I U I L C S L E E H G Q V T F Z V L C F L L E Z N E J K Q

Z Z M G T N Q E L M B F G Y E J K Z A E E F K E V T S K P D

L I B H J F J S F A Z N Y K S H V F N R S C F J L A E X M E

P Z U B N T O P L W B L A W J Q X I M M L T A L M Y N N R C

E Q S H F R V O Q E Z E I R M C H E U H B V M B Q E O X I O

R Y D P U E O R U I R F S K C I O L T U F A G X N K C D S G

S O A S J J J C M J P R C A Z A R D U Q P Z A Q A H E P W D

I E Y K A T Y D I D O U I X B U C H A L W J L W P R N H A X

M L T W E S I P E L E P Q U S I H O Y X R W F J P S I K W F

M B G G E W C H N U D P S S Q H A C Y S C H I L L Y P P Z T

O Q P L W O R L D S E R I E S S R K T M P V I Q E T I P D E

N X A A L V R G M L R X V D O F D E Z Y A Q B T S Y H A X D

S B R T Z H T W L D P O F N A M C Y R E P P O H S S A R G H

PCLinuxOS Puzzled Partitions

PCLinuxOS Word Find: September 2018
Autumn

http://pclosmag.com/html/Issues/201809/files/2018-09-PuzzleSolutions.pdf
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1. a day or period of celebration, sometimes a
religious commemoration.

2. gathering food that has been grown to store
for winter

3. one of America’s favorite games, typically
played in the fall

4. a series of contests between a number of
competitors, who compete for an overall
prize.

5. the commercial organization and operation
of visits to places of interest.

6. the date in the fall when day and night are
of equal length

7. ice crystals formed when the temperature
is below freezing

8. a large vegetable, enjoyed in pies and carved
with faces

9. one of America’s favorite games, typically
played in the summer

10. the most well-known baseball tournament
in the US

11. this is the _____________ issue of the
magazine

12. a party held in the back of your pickup,
generally at a sporting event

13. a US holiday commemorating the discovery
of the New World in 1492.

14. a period of unusually dry, warm weather
occurring in late autumn

15. have to gather these from the yard
every autumn

16. a drink made by crushing fruit, typically
applesDownload Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Autumn Crossword

http://pclosmag.com/html/Issues/201809/files/2018-09-PuzzleSolutions.pdf
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From the computer ofms_meme:
Everyday I work the daily crosswords and cryptograms in the paper. I like the cryptograms as they are wise/silly sayings of famous people. The magazine article
about secure passwords made me think of the cryptograms. We have people in the forum who are always posting famous/wise/silly sayings. I have made a few
into cryptograms, and hope our readers will enjoy them.

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Cryptograms

http://pclosmag.com/html/Issues/201809/files/2018-09-PuzzleSolutions.pdf
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Posted by Meemaw, on August 17, 2018, running Xfce. Posted by parnote, on August 17, 2018, running Xfce.

Posted by rootazoid, on August 14, 2018, running Mate. Posted by davecs, on August 21 , 2018, running LXDE.

More Screenshot Showcase




